<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Device List and Specification</td>
<td>3</td>
</tr>
<tr>
<td>1.1.</td>
<td>Device List</td>
<td>4</td>
</tr>
<tr>
<td>1.2.</td>
<td>Specification Parameter</td>
<td>5</td>
</tr>
<tr>
<td>1.3.</td>
<td>System Requirement</td>
<td>6</td>
</tr>
<tr>
<td>2.</td>
<td>Installation Notes</td>
<td>7</td>
</tr>
<tr>
<td>2.1.</td>
<td>Hardware Installation</td>
<td>8</td>
</tr>
<tr>
<td>2.2.</td>
<td>Software download</td>
<td>11</td>
</tr>
<tr>
<td>2.3.</td>
<td>Software Installation</td>
<td>12</td>
</tr>
<tr>
<td>3.</td>
<td>Software Introduction</td>
<td>13</td>
</tr>
<tr>
<td>3.1.</td>
<td>Scan Preparation</td>
<td>14</td>
</tr>
<tr>
<td>3.2.</td>
<td>First Scan</td>
<td>15</td>
</tr>
<tr>
<td>3.2.1.</td>
<td>Help Mode for Beginners</td>
<td>15</td>
</tr>
<tr>
<td>3.2.2.</td>
<td>Obtain License File</td>
<td>15</td>
</tr>
<tr>
<td>3.2.3.</td>
<td>Operation Procedure</td>
<td>15</td>
</tr>
<tr>
<td>3.3.</td>
<td>Drop down Menu</td>
<td>17</td>
</tr>
<tr>
<td>3.3.1.</td>
<td>Language</td>
<td>17</td>
</tr>
<tr>
<td>3.3.2.</td>
<td>TeamViewer</td>
<td>17</td>
</tr>
<tr>
<td>3.3.3.</td>
<td>Feedback</td>
<td>18</td>
</tr>
<tr>
<td>3.3.4.</td>
<td>User Setting</td>
<td>18</td>
</tr>
<tr>
<td>3.3.5.</td>
<td>Factory Default</td>
<td>19</td>
</tr>
<tr>
<td>3.3.6.</td>
<td>Einscan Community</td>
<td>19</td>
</tr>
<tr>
<td>3.3.7.</td>
<td>About</td>
<td>19</td>
</tr>
<tr>
<td>3.4.</td>
<td>File Preview</td>
<td>19</td>
</tr>
<tr>
<td>4.</td>
<td>Calibration</td>
<td>21</td>
</tr>
<tr>
<td>4.1.</td>
<td>Calibration</td>
<td>22</td>
</tr>
<tr>
<td>4.2.</td>
<td>Calibration Precaution</td>
<td>25</td>
</tr>
<tr>
<td>5.</td>
<td>Fixed Scan</td>
<td>26</td>
</tr>
<tr>
<td>5.1.</td>
<td>Help Mode for Beginner</td>
<td>27</td>
</tr>
<tr>
<td>5.2.</td>
<td>Before Scanning</td>
<td>28</td>
</tr>
<tr>
<td>5.3.</td>
<td>Scanning</td>
<td>30</td>
</tr>
<tr>
<td>5.3.1.</td>
<td>Start Scan</td>
<td>30</td>
</tr>
<tr>
<td>5.3.2.</td>
<td>Edit Tool</td>
<td>30</td>
</tr>
<tr>
<td>5.3.3.</td>
<td>Manual Align</td>
<td>31</td>
</tr>
<tr>
<td>5.3.4.</td>
<td>Delete Current Data</td>
<td>32</td>
</tr>
<tr>
<td>5.3.5.</td>
<td>Pause</td>
<td>32</td>
</tr>
<tr>
<td>5.4.</td>
<td>After Scanning</td>
<td>32</td>
</tr>
<tr>
<td>5.4.1.</td>
<td>Mesh</td>
<td>32</td>
</tr>
<tr>
<td>5.4.2.</td>
<td>Data Post Processing</td>
<td>34</td>
</tr>
<tr>
<td>5.4.3.</td>
<td>Brightness/Contrast</td>
<td>37</td>
</tr>
<tr>
<td>5.4.4.</td>
<td>Save Your Data</td>
<td>37</td>
</tr>
<tr>
<td>5.4.5.</td>
<td>Share Your Data</td>
<td>38</td>
</tr>
<tr>
<td>5.4.6.</td>
<td>Solid Edge</td>
<td>39</td>
</tr>
</tbody>
</table>
Device List and Specification
## Device List

<table>
<thead>
<tr>
<th>Items</th>
<th>Picture</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner Head</td>
<td><img src="image" alt="Scanner Head" /></td>
<td>1</td>
</tr>
<tr>
<td>Turntable</td>
<td><img src="image" alt="Turntable" /></td>
<td>1</td>
</tr>
<tr>
<td>Scanner Stand</td>
<td><img src="image" alt="Scanner Stand" /></td>
<td>1</td>
</tr>
<tr>
<td>Scanner Bracket</td>
<td><img src="image" alt="Scanner Bracket" /></td>
<td>1</td>
</tr>
<tr>
<td>Calibration Board</td>
<td><img src="image" alt="Calibration Board" /></td>
<td>1</td>
</tr>
<tr>
<td>Calibration Board Holder</td>
<td><img src="image" alt="Calibration Board Holder" /></td>
<td></td>
</tr>
<tr>
<td>Power Adapter</td>
<td><img src="image" alt="Power Adapter" /></td>
<td>1</td>
</tr>
<tr>
<td>Power Cord</td>
<td><img src="image" alt="Power Cord" /></td>
<td>1</td>
</tr>
<tr>
<td>USB Cable</td>
<td><img src="image" alt="USB Cable" /></td>
<td>1</td>
</tr>
<tr>
<td>USB Cable</td>
<td><img src="image" alt="USB Cable" /></td>
<td>1</td>
</tr>
<tr>
<td>Tripod</td>
<td><img src="image" alt="Tripod" /></td>
<td>1</td>
</tr>
<tr>
<td>Reference Point</td>
<td><img src="image" alt="Reference Point" /></td>
<td>1</td>
</tr>
<tr>
<td>Quick Guide</td>
<td><img src="image" alt="Quick Guide" /></td>
<td>1</td>
</tr>
</tbody>
</table>
### 1.2. Specification Parameter

<table>
<thead>
<tr>
<th>Model</th>
<th>EinScan-SP</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Mode</strong></td>
<td>Fixed Scan (With Turntable)</td>
</tr>
<tr>
<td><strong>Scan speed</strong></td>
<td>&lt;1min</td>
</tr>
<tr>
<td><strong>Point distance</strong></td>
<td>0.17mm~0.2mm</td>
</tr>
<tr>
<td><strong>Accuracy</strong></td>
<td>Single Scan</td>
</tr>
<tr>
<td></td>
<td>Accuracy: 0.03mm</td>
</tr>
<tr>
<td><strong>Suitable distance</strong></td>
<td>290—480mm</td>
</tr>
<tr>
<td><strong>Light source</strong></td>
<td>White light LED</td>
</tr>
<tr>
<td><strong>Maximum scan volume</strong></td>
<td>30mm<em>30mm</em>30mm</td>
</tr>
<tr>
<td></td>
<td>30mm<em>30mm</em>30mm</td>
</tr>
<tr>
<td><strong>Minimum scan volume</strong></td>
<td>200mm<em>200mm</em>200mm</td>
</tr>
<tr>
<td></td>
<td>700mm<em>700mm</em>700mm</td>
</tr>
<tr>
<td><strong>Texture Scan</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Outdoor Operation</strong></td>
<td>No (affected by strong light)</td>
</tr>
<tr>
<td><strong>Special Scan Object</strong></td>
<td>For transparent, reflective and dark object, please spray powder first before scanning</td>
</tr>
<tr>
<td><strong>Printable Data Output</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Data Format</strong></td>
<td>OBJ, STL, ASC, PLY, 3MF</td>
</tr>
</tbody>
</table>
### 1.3. System Requirement

<table>
<thead>
<tr>
<th>Items</th>
<th>Recommended PC configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Win7, 8, 10, 64bit</td>
</tr>
<tr>
<td>Port</td>
<td>at least one USB2.0/3.0 port</td>
</tr>
<tr>
<td>RAM</td>
<td>&gt;16G</td>
</tr>
<tr>
<td>Graphic Card</td>
<td>NVIDIA Series, GTX or better</td>
</tr>
<tr>
<td>Graphic Memory</td>
<td>&gt;2G</td>
</tr>
<tr>
<td>CPU</td>
<td>i5 or higher</td>
</tr>
</tbody>
</table>
Installation Notes
2.1. Hardware Installation

**Scanner Set-up**

- Step 1. Place the scanner head onto the bracket.

- Step 2. Insert calibration board onto the board holder.
  NOTE: Rotate the calibration board only while calibration.

- Step 3-1. Turntable and Scanner installation.
  1) Place the turntable onto scanner stand.
  2) Screw the scanner into the socket on the stand.
Step 3-2. Setting scanner on tripod for fixed scan, turntable coded targets and markers align mode.

1) Screw the scanner head onto tripod.

2) Plug power cord into outlet and the back of scanner; Plug USB cable into back of scanner and computer USB port; Plug USB cable into back of scanner, and turntable.
Hardware Installation

**Scanner Turn-on/off**

- Hold on the touch switch for about one second to turn the scanner on;
- Double-click on the touch switch and stay for one second each time to turn the scanner off.
2.2. Software download

Firstly, enter the Support page: http://www.einscan.com/support. Click “Software download”, as shown below:

Secondly, please complete the registration, if registered, click log in.

After take the survey, it will enter the page http://www.einscan.com/software-download

Download & Service

Finally, click the icon to jump to the page of any file to download the software.
2.3. Software Installation

Double click installation package, Follow the instructions as the window pops up. Users can either choose the default installation path or click the Browse button to select the installation path. Default installation is suggested.

When installation is finished, there will be a shortcut of the software and on the desktop.

The shortcuts are:
- Software
- File Preview Tool
- Teamviewer
- Uninstall

In the next step, connect the device and check whether the camera driver installation is successful, right click “Computer”, choose “Computer Management”-“Device Management”-“Imaging devices” to check if the camera display normally.

Note: You should One-click on the touch switch to turn the scanner on.

Software Uninstall

Open the start menu, choose Shining3d_EinSca-Pro----Click “Uninstall” or go the Control Menu to uninstall.
Software Introduction
3.1. Scan Preparation

**Mode selection**

(1) Fixed Scan (With Turntable): This mode is recommended for objects within the size of 200*200*200mm.

(2) Fixed Scan (Without Turntable): This mode is recommended for objects over the size of 200*200*200mm, as well as a comparative stable environment (without obvious vibration) are required.

  Do not touch or move the object being scanned while the scan is in progress. Do not scan moving object, size smaller than 30*30*30mm, and objects with hollow pattern design.

**Mark points stick**

Stick mark points on the object in random, avoiding sticking in one line. Public areas alignment require at least four mark points. While placing the points, uniformly stick the mark points on the object, and make sure that in each single scan area has at least 4 points.

**Special objects**

Before scan objects in transparent, semi-transparent or black shall spray on the surface.
3.2. First Scan

Choose the device “EinScan-SP”, as shown below.

3.2.1. Help Mode for Beginners

Close Help Mode for Beginner by clicking the top right corner. To open Help Mode for Beginner, go to Menu -> User Setting -> Help Mode for Beginner

3.2.2. Obtain License File

When a warning of license file doesn’t match the scanner pops up when entering scanning mode, the license file can be acquired by clicking “Activate”.

3.2.3. Operation Procedure
3.3. Drop down Menu

Click ▼ from the upper right to open drop down menu.

![Drop down menu](image)

3.3.1. Language

This software version is including Simplified Chinese, Chinese, English, German, Japanese, Spanish, French, Korean, Russian and Turkish. Language can be switched in the **choose device type interface**.

![Language options](image)

3.3.2. TeamViewer

By clicking TeamViewer, you can go to the TeamViewer interface directly without installation.
3.3.3. Feedback

If you have any questions, or suggestions, please share with us by clicking “Feedback”. Leave your email in “My E-mail”.

3.3.4. User Setting

Debug window

Tick the checkbox to open debug window; if you want to close it, unselect it.

Help Mode for Beginners

Help Mode for Beginner is the default selection, which is to guide the new users make a scan completely step by step. Close Help Mode for Beginner by clicking the top right corner. To open Help Mode for Beginner, go to Menu -> User Setting -> Help Mode for Beginner.
User Experience Program

To help us improve the quality and user experience of Einscan, we hope to be allowed to collect usage information to Einscan Team. This information will not identify you and does not include your project data. By default, this checkbox is selected, and we strongly recommend you to select it.

3.3.5. Factory Default

System setting (brightness, turntable steps), calibration data will restore to the factory default settings. Language will be changed into English as default. Factory Default will require software restart.

3.3.6. Einscan Community

Official Website (http://www.einscan.com/) refers to SHINING3D official website for product and information.
Community (http://www.einscan.com/einscan-experts-forum) refers to SHINING3D forum for all EinScan users to discuss and share the experience.
Facebook (https://www.facebook.com/groups/einscan) refer to facebook for Einscan users to discuss and share the experience.

3.3.7. About

Software version information, and technical support mail can be found here.

3.4. File Preview

You can open file preview tool through a desktop shortcut or from the start menu. Start previewing by dragging the file into the window. Supporting formats include asc., stl., ply., obj., and 3mf. As the picture shows below, file path shows in the title bar.
Drop down Menu
Scanning cannot be entered if calibration is not done after installing the software. There is a WARNING: No calibration data, please calibrate first.
4.1. Calibration

Click ‘Calibrate’ to enter the interface of calibrate. If there is no calibration data, choose device type and it will enter the calibration interface automatically.

The interface of calibrate:

Calibrating your scanner is important in order to get accurate scan results. The
following describes the three steps required to successfully calibrate your device.

Follow the software operation guide, adjust the distance between the projector and calibration board, and the cross from scanner should target at the calibration board n clearly.

Place the calibration support and board in the center of the turntable as shown in Figure A. Check that the calibration board is located at the center of the turntable with the Figure A pattern facing the scanner and click “Snap”. Do not interfere or touch the calibration board during the calibration sequence.

⚠️ Don’t move the support. Only rotate the calibration board.

After the 1st calibration sequence, the turntable will stop and the display will show what is in Figure B. Being careful not to move the support, remove the calibration board, rotate it 90° counterclockwise and place the board back onto the support as shown in Figure B.

⚠️ Note: Don’t move the support. Only rotate the calibration board.

Being careful not to move the support, remove the calibration board, rotate it 90° counterclockwise and place the board back onto the support as shown in Figure C.
Upon completion of the 3rd calibration sequence, the software will automatically calculate and archive the current conditions. This calculation may take several seconds but once complete, you are ready to start automatic turntable scanning.

When calibration is finished, the software will close the calibration window automatically and enter the scan mode selection page.

If the calibration fails, please try to re-calibrate following the instructions above. If calibration fails again, please contact your local support representative.
4.2. Calibration Precaution

You must finish all the calibration steps according to the instruction when you calibrate at the first time. Situations as below need do calibration again:

① When the scanner is used for the first time or after long time without using.
② When there is strong vibration during the transportation.
③ When alignment mistake or failure frequent appear during the scanning.
④ When scanning data is incomplete and quality is much worse during the scanning.
Fixed Scan
5.1. Help Mode for Beginner

Choose Fixed Scan, as shown below, click “Next”.

Help Mode for Beginner is the default selection, which is to guide the new users make a scan completely step by step. Close Help Mode for Beginner by clicking the top right corner.

Under the Help Mode for Beginner, following the guidance step by step, you will finish a scan following: **New Project -> Texture/Non-texture -> adjust brightness -> start scanning -> Edit -> Continue Scan/Mesh -> Mesh type: Watertight/ Un-watertight -> Post Processing -> Save data**
5.2. Before Scanning

Enter the interface of New Project and Open Project, the default project save location is the desktop, then it will remember where the user last created a new project. Click “New Project”, enter the project name, then click ‘Save’ to enter the interface of Non-texture Scan and Texture Scan selection.

Choose ‘Texture scan’ to enter the white balance test.

**White Balance Test**

When scanning a colored object, you’ll need to perform a white balance test to achieve better scanning results. Place a sheet of white paper as shown below on the calibration plate and click “Restarting white balance test ?”.

After the white balance test has completed, you are free to continue with the texture scan.

**Adjust Brightness**

Adjust the distance between the object and device (suitable working distance is 290 ~ 480mm), until the cross is clearly to be seen on the object.

Most users will find that the automatic settings work just fine.
but for more complex objects or lighting conditions, you can manually adjust scanner settings. Choose your desired brightness setting if the object is over or under exposed. Click "Apply" to confirm, or click "Cancel" to not save.

Enter the interface of fixed scan, check “With Turntable”

**Work distance:** Adjust the distance between the object and device (suitable working distance is 290 ~ 480mm), until the cross is clearly to be seen on the object.

**Camera viewport**  
Tick [ ] to display the right camera viewport and texture camera viewport. The left camera viewport always display.

Click [ ] in the lower right corner of the camera viewport to zoom the camera viewport

**Adjust Brightness**  
Drag the button to adjust the brightness. The brightness is appropriate at the right scan distance: equipment against objects, the cross is clearly in the brightness viewing window. This function is the same as the adjust brightness when new a project.

**With Turntable**  
If you don’t choose “With Turntable” option, you will get single piece of data; if choose this option, the scanner will use turntable to scan and choose turntable steps.

**Turntable Steps (8-180)**  
Before scanning, you can set the scan times per round under turntable scan. The default setting is 8 times.

**Align Mode**  
The default is turntable align mode, you can also choose markers.
Fixed Scan

turntable coded targets and feature align mode. Align mode can be re-selected after the turntable has rotated one circle. You can click for help.

If you choose turntable coded targets, you must set the scanner on tripod.

⚠️ Note:
1. Choose turntable coded targets align mode, Please make sure that the object won’t block the coded targets on the turntable. **You can set scanner on tripod.** Or, there will be no fringe pattern, while turntable will be still rotating. If the scanned object is too high and will block the coded targets on turntable, you can stick mark points on it (if allowed) to continue auto scan. At this time, please make sure that the coded targets on the turntable are covered, so as not to affect the scanning. Make sure that in each single scan area has at least 4 points. Refer to **Scan Preparation**.

**HDR**
Enable HDR brightness can scan bright and dark objects. The function is the same as Adjust brightness “Bright&Dark”.

5.3. Scanning

5.3.1. Start Scan

Click the button or press space button to start scanning. After the turntable has rotated one circle, you can change with turntable or not, turntable steps and align mode.

5.3.2. Edit Tool

![Edit buttons](image.png)

You can edit the current part data after each scan. You can do the below edition if the data has excess parts, both data and mark points can be edited.

**SHIFT+Left mouse:** Select excess parts, the selected section is displayed in red, as shown below.
Ctrl + Left mouse: deselect selected data

Delete selected data
Click the button and “DELETE” in the keyboard to delete selected data.

Undo
You can only undo the last deleted data.

Show/Hide Stripes
Click the button to switch the texture display and hide. Non-texture scan, there is no such button.

End single-piece edit
Click ✔ to save data and exit the single-piece edition; Click ✗, delete the current scan data.

After end the single-piece edit, the right toolbar will display, and now can edit the whole scan data. The specific operation is the same as the single-piece edit.

5.3.3. Manual Align

Align
If automatic alignment failed during scanning, you can use manual align. Click the button to open Manual Align view port on the left side of the software.
Keep SHIFT down, and click left mouse button to select at least 3 non-collinear corresponding points in the 3D preview windows for Manual align, As shown on the right. 

**Note:** If you choose wrong points under manual alignment, you may press Esc button to cancel the points one by one in order, until you exit manual alignment.

### 5.3.4. Delete Current Data

**Delete the Current Data**

If you are not satisfied with current scanning data, or there is not enough overlapping region for registration, click the button to delete current data and then change the position of the scanner or the object to scan again.

When auto scan mode is scanning, you can click the button to stop the current scan. The current data will be deleted directly.

⚠️ **Note:**

When import project, click button the fixed scan is remove the single data; Auto scan is to delete all the data.

### 5.3.5. Pause

**Pause**

Click the button, scanning will pause; Click again to resume scanning.

### 5.4. After Scanning

#### 5.4.1. Mesh

When the scan is completed, click the button, proceed to post-processing. You will see two modes after clicking the button: Watertight and Unwatertight. Watertight usually slower than unwatertight. Texture scan mode will take more time compared to Non-Texture scan mode.

**Watertight**

Closed model can be printed directly. After choose this mode, you should select the object details.

Select High for objects with fine texture, select Med or Low for objects in smooth
surface or with less detail. The time for data processing is in relation to the detail setting. The higher the level of details is, the longer time the processing takes. It may keep for a long time in 95%, please be patient.

Select the object details:

- High detail
- Medium detail
- Low detail

Unwatertight

Unclosed model. The following picture is the watertight and unwatertight model.

Watertight

Unwatertight

Texture watertight results:
5.4.2. Data Post Processing

After meshing, the following dialogue box of data post processing will appear. You can simplify the data per your request, do fill holes, sharpening or smoothing operations. Unwatertight and watertight, the post processing of the interface as shown below.

**Data simplification**

After simplification, the polygon numbers, size and surface detail of data will be reduced accordingly. Check the simplify check box and set the ratio, the default is 100%.

The comparison of detail between before simplification and after simplification (at 30% simplify proportion).
Fill holes

The default does not check the mark point and fill hole, check the fill hole you need set perimeter, choose 10-100mm perimeter to fill the hole, less than the perimeter of the hole will be filled. Mark point fill hole as an example.

⚠️ Note:
1. If the edge of the hole is not smooth may cause the effect is not good, not recommended to fill hole.
2. Hole-filling: choose 10-100mm perimeter to fill the hole;

Smooth

The data to denoise processing, improve data quality, the figure before and after smoothing:
Before smooth  
After smooth

**Sharpen**
Improve the overall clarity of the data, the figure below before and after sharpening:

Before sharpen  
After sharpen

**Optimize the texture**
This option is only available when the scan data is with texture. Click this function to optimize color texture of the model, which can make the color closer to the model but take more time for processing.

Not optimize  
Optimize texture
Texture layout optimization
If you need to edit the texture later, you can select this function, but this is time-consuming.

| No optimization | Texture layout optimization |

5.4.3. Brightness/Contrast

After meshing project with texture, you may adjust brightness/contrast under the camera viewport.
Brightness (-100—100): shows the brightness of the picture. The higher the value is, the brighter.
Contrast (-100—100): shows the contrast of the colors. The higher the value is, the more color gradient layers.

5.4.4. Save Your Data

Before merging can save data as asc single. After merging, it can be saved as asc, stl, ply and obj. To save color texture, please select Ply and obj.

Scale
Scaling the volume of scanning data, while the quantity of triangular facets and size of data will not be changed. Scaling result as reference: From left to right shows double size, original size
and half size respectively.

<table>
<thead>
<tr>
<th>Original size (mm)</th>
<th>After scaling (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>87.30</td>
<td>87.30</td>
</tr>
<tr>
<td>109.04</td>
<td>109.04</td>
</tr>
<tr>
<td>91.55</td>
<td>91.55</td>
</tr>
<tr>
<td><strong>Scaling ratio</strong></td>
<td><strong>100</strong></td>
</tr>
</tbody>
</table>

5.4.5. Share Your Data

Click the button after merging to share data, it will show the dialog as below. You can share your model to Sketchfab, while model title, username and user password are required. Register an account and look at the shared model at http://sketchfab.com.

⚠️ **Note:**
Sketchfab Normal account can only upload data maximum 50M, while Professional account can share maximum 200M, and set model as private.
5.4.6. Solid Edge

If Solid Edge software is already installed, click the button to open the software. The meshed STL data will also be exported to Solid Edge.

5.4.7. Project

You can new or open projects. The default project location is the desktop, then it will remember where the user last created a new project.

⚠️ Note:
The projects created by auto scan and fixed scan can be reciprocally imported. After importing the project, direct access to scan, choose the scan mode based on whether the imported project is texture.

5.4.8. Back to home

If you want to change the scan modes, click the button to go back to the homepage to select the scan mode.

5.5. Others

5.5.1. Mouse Operation Prompts

Lower left corner of the interface is the mouse operation prompts:

- After scanned or imported project, the prompt text is as follows:
  - **Hold down the left mouse button**: Rotate the object;
  - **Hold down the middle mouse button**: pan the object;
  - **Hold down the mouse wheel**: Scroll up and down to the object; scroll down to enlarge the object;
  - **Hold down the Shift + left mouse button**: select the area on the object;
  - **Delete**: Delete the selected area.

- **Hold down the Ctrl + left mouse button**: deselect selected data;

- **Manual align**, the prompt text is as follows:
  - **Press and hold shift + left mouse click**: Select point to start manual align
5.5.2. Hot Key

**Space button:** To start scan or during single-piece edit to save data and exit the single-piece edition.

**ESC button:** To close the pop-up windows, such as new project, select texture, choose mesh type and so on.

5.5.3. Points and Triangles

<table>
<thead>
<tr>
<th>Current Points</th>
<th>Current Triangles</th>
</tr>
</thead>
<tbody>
<tr>
<td>560620</td>
<td>554588</td>
</tr>
</tbody>
</table>

**Current Points and Triangles**

When scanning it will show the current points and current triangles in the lower right corner. When you edit the scan data, the current points and the current triangles change in real time.

5.5.4. Help

Click this button to get the operation manual and notes in more detail under the current step.

The following picture shows the help information of new project.
5.6. Work Offline

You can use software without scanner connection. You can do edition, manual align, delete, mesh, save data, share data and so on.
Fixed Scan (With Discovery)
6.1. System Requirement

<table>
<thead>
<tr>
<th>Items</th>
<th>Recommended PC configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Win7, 8, 10, 64bit</td>
</tr>
<tr>
<td>Port</td>
<td>at last one USB 3.0 port</td>
</tr>
<tr>
<td>RAM</td>
<td>&gt;16G</td>
</tr>
<tr>
<td>Graphic Card</td>
<td>NVDIA Series, GTX or better</td>
</tr>
<tr>
<td>Graphic Memory</td>
<td>&gt;2G</td>
</tr>
<tr>
<td>CPU</td>
<td>i5 or higher</td>
</tr>
</tbody>
</table>

6.2. Choose Scan Mode

When connect Discovery module, there will be General scan and Discovery scan. General scan use EinScan-SE to scan, Discovery scan use Discovery module to scan, as shown below, choose Discovery scan.

**Note:** Discovery need to connect to USB 3.0 port.
Fixed Scan (With Discovery)

Enter the work mode interface, as shown below, the calibration operation can refer to 4. Calibration.

Choose Working Mode

Enter Discovery scan, where new project choose texture scan, Choose “Using Light Box” when there is a lamp house connected; if without a lamp house, please select “No Light House”.

6.3. White balance test

Enter Discovery scan, where new project choose texture scan, Choose “Using Light Box” when there is a lamp house connected; if without a lamp house, please select “No Light House”.

Put the white paper as shown in the picture and ensure the preview window filled with the white
paper. Adjust the brightness of the preview window. When the brightness is proper, click “Start white balance”.

After white balance testing, check again the preview window, making sure the color of the white paper is close to the actual color and then click “Apply”. The white balance window will be automatically closed.
6.4. Adjust Brightness

Adjust the distance between the object and device (suitable working distance is 290 ~ 480mm), until the cross is clearly to be seen on the object.

Most users will find that the automatic settings work just fine but for more complex objects or lighting conditions, you can manually adjust scanner settings.

Choose your desired brightness setting if the object is over or under exposed. Click “Apply” to confirm, or click “Cancel” to not save.

Edit, manual align, delete data, mesh, save data and share refer to Fixed Scan.
7

FAQ
FAQ

1. What if no scan data when the turntable has rotated one circle?

Solution: Please make sure that the object won’t block the mark points on the turntable. Or, there will be no fringe pattern, while turntable will be still rotating. If the align mode is mark point, please make sure that the marks on the turntable are covered, so as not to affect the scanning. Make sure that in each single scan area has at least 4 points.

2. What if the merging fails without mark points when the turntable has rotated several circles or when it is under fixed scan mode?

Solution: Try to make sure there are at least 1/3 overlap between the current scan area and the previous scan area and the object surface should be featured. For objects which are symmetric and without rich features, using mark points or manual merger is recommended.

3. How to scan objects in transparent, semi-transparent or black?

Solution: Scan before spraying on the surface.

4. Under auto scan mode, if the turntable is not moving, but with a humming sound, how to solve?

Solution: Disconnect power line and connect again in few seconds.
8

Safety Precautions
Safety Precautions

- Keep well-ventilation. Environment temperature shall below 40 Celsius degree, and do not use the device under an environment with flammable or corrosive gases or another similar environment.

- Please grab and place gently in the proper position, and do not squeeze it. Prepare precautions like sunscreen, rain-proof, shock-proof and etc. No matter on sunny or rainy days.

- If the device could not function correctly, fixing the device by opening it by yourself is not allowed. The device shall be repaired by professional technicians or under their instruction.

- You should send the device to facilities with qualification for recycling it instead of dropping into the household garbage when it is scrapped.
Contact us

Email: einscan_support@shining3d.com

More scanning information

More scanning information can refer to http://www.einscan.com ---Support